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WELCOME TO EASY COLOR PAINT (ECP), Version 0.4

Overview

This program, ECP 0.4, contains the basic features of a color paint program, including patterns,
fatbits, and cut-and-paste. It was originally designed for children under 12 but, in its present
form, it should appeal to children of all ages. It's been tested with Systems 5.0 and 6.0.2, and it's
compatible with Multifinder. Before launching ECP, use the Control Panel to set your Mac II to
16-color mode.

ECP is written in Lightspeed C 3.0, and it's  freeware: please distribute it freely, along with its
companion  files  (namely  this  documentation  file  and  any  accompanying  example  pictures).
Comments or questions may be directed to the programmer at the following address:

Bruce Ballard
55 Clinton Avenue
New Providence, New Jersey, 07974, USA

bwb@allegra.att.com

To receive an update of ECP about May 1, 1989, please send $2.00 to cover postage and the cost
of the disk to this address. I'll try to incorporate as many suggestions as possible that I receive
before then.

In this document, letters in parentheses denote keyboard equivalents (press the indicated key
while holding down the Apple/Command key).

The Menubar

The menubar  consists  of  the  standard  Apple,  File,  and Edit  menus,  followed by menus  for
Windows and Tools and, to the right of these, a varying number of additional menus, depending
on the tool currently in use.

The  Apple menu contains a standard "about" box, followed by desk accessories and, if you're
running Multifinder, whatever items Multifinder chooses to display.

The File menu contains the standard entries Open(O), Save(S), Save-As, and Quit(Q). Pictures
are saved as ECP documents, which can be retrieved later by double-clicking their icon. If you
ask to quit before saving your picture., you'll be asked for confirmation. "Save" and "Save-as"
are treated alike: if you're asking to overwrite a file, you'll be asked for confirmation.

The Edit menu contains standard entires for editing, each of which will be dimmed when it is not
applicable.  Cut(X) and Copy(C) each copy into the clipboard the region that you've selected
using  the  Mark  tool  (discussed  below),  after  which  Cut  fills  the  region  with  the  current
background color. Paste (V) lets you read an area you've previously saved within ECP or a PICT
that you've previously stored in the clipboard from another application (e.g. by doing a Cut or
Copy). Reading a PICT lets you to read black-and-white pictures and then colorize them (the
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Bucket tool can be quite useful for this).

The  Windows menu allows you to  Clear the  window (after  supplying confirmation),  Invert
either the entire window or a region outlined by Mark (e.g. pink "inverts" to light brown and vice
versa), or display any of the 5 basic windows provided by ECP (e.g. when a 
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window has  gotten  buried.  It  also  lets  you  Flip,  horizontally  or  vertically,  either  the  whole
window or the region selected by the Mark tool 

The  Tools menu lets you select from the basic program modes, namely Brush(B), Bucket(K),
Rectangle(R), Round Rectangle(D), Oval(C), Triangle-Plus(T), Line(L),  Words(W), Mark(M),
and Fatbits(F). Each of these tools will be discussed shortly.

The Size menu lets you choose the size of the paint brush and the lines drawn by the Line tool
and the various shape tools (Rectangle, etc.). Note that the sizes 1-9 may be selected as keyboard
equivalents, and a size of 10 with the keyboard equivalent of 0.

The  Shapes menu lets you specify whether shapes (Rectangle etc.) are to be filled in, hollow,
filled-in with a border, or hollow with borders. The width of hollow shapes is determined by the
Size menu, while the borders are thin (1-pixel) lines drawn in the foreground color.

The Corners menu lets you specify how rounded you want the corners of Round Rectangles to
be.

The Words menu lets you choose the character face (i.e. plain, bold, italic, underlined, outlined,
shadowed, or any combination of these) and the charcter size. [At present, only the standard
Geneva font is provided.]

Windows

ECP works with 6 windows, 5 of which appear when you launch the application and one  of
which ("fatbits") comes up when you enter fatbits mode. Each window has its own appearance
and functionality and may be moved or closed. When a window has been closed or becomes
obscured, it can be restored by choosing the associated option in the Windows menu. 

The primary drawing window appears near the upper left of your screen. All graphic operations
will take place in this window. It's initially labled "Untitled" but will take on the filename you've
most recently read or saved. It's probably a good idea not to cover up this window with other
windows.

The Patterns window presents a standard set of 38 Macintosh patterns ranging from solid to brick
to tapestry. When colors have been selected from the Colors window, all  black pixels in the
currently selected pattern will appear in the foreground color, while white pixels will appear in
the background color. For example, you might choose to paint red bricks with black between
them. The currently selected pattern is "highlighted" by a heavy border. [This highlighing also
occurs in the "status square" in the Colors window, which lets you see exactly how the currently
specified foreground and background colors will appear when applied to the selected pattern.] If
part of the Patterns window becomes obscured, you may uncover it either by clicking in a non-
pattern  portion  of  it  (e.g.  between  the  patterns)  or  by  selecting  "Show  Patterns"  from  the
Windows menu.  You may close  this  window and later  reopen it  using  this  menu item. The
initially selected pattern is the all-black-pixels pattern, which means that you'll be painting with a
solid color.

The  Tools window lets the tool icons that appear in the Tools window remain visible. Older



-4-
children,  and adults,  may want  to  close it  using the close box at  the  top  left  since since it
obscures the Mixtures window discussed below and since each of the tools can also be selected
from the Tools menu or through its keyboard equivalent.
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The Pure Colors window lets you select foreground and background colors, which are found in
the top and bottom rows respectively. The foreground color will be applied to the black pixels in
the currently selected pattern (the intial pattern is all-black) and the background color to the
white pixels of the selected pattern. Each of the current color settings is indicated by a form of
highlighting like that used for patterns. The Pure Colors window also lets you see what is to be
painted or drawn on the screen via the large "status square" appearing about one inch from the
left  edge  of  the  screen.  Finally,  there  is  a  "back  up"  item which  restores  the  screen  to  its
appearance just before one of the last updates (see below for more information on saving and
restoring the screen). For convenience, selecting as a foreground color the foreground color that's
already current causes the pattern to be set to the all-black-pixels pattern.

The Mixtures window shows each of the 66 "ditherings" that can be made by selecting exactly
two colors from the first 12 pure colors and applying these to the "gray" pattern (the 4th one in
the leftmost column) that contains 50% black bits and 50% white bits. When you select a color in
the Mixtures window,  you'll see the pattern and pure color selections change accordingly.

The  Shapes and  Cut and Paste windows have to do with the Triangle-Plus and Fatbits  tools
discussed below.

Tools

The Paint Brush(B) tool paints the screen based on the current foreground and background colors
(initially black and white), the selected pattern (initially the all-black-bits pattern), and the brush
size (initially 10). When you're in Paint Brush mode, ECP will drag a square representing the
brush around the screen that shows the "inverse" of the bits beneath it. For small brush sizes,
however, a pencil-shaped cursor will appear. When you're painting (i.e. you've clicked the mouse
in the primary painting window and haven't yet released it), no cursor or inverse-square appears,
but you can usually tell where the brush is since you'll see its effects taking place as you move
the mouse. Naturally, you may release the mouse momentarily and then press it again in order to
be sure where it's positioned.

The Bucket(T) tool lets you spill paint, based on the foreground and background colors and the
selected pattern. The "hot spot" associated with the bucket cursor, i.e. the single pixel on the
screen considered to be the mouse position, is the end of the dripping paint on the right side of
the bucket cursor. The effect of spilling paint is to cover all pixels that are the same color as the
pixel  where  the  mouse  was  clicked  and  which  can  be  reached  by  horizontal  and  vertical
movements without moving across differently colored pixels. If in doubt, experiment;  it  will
become clear quickly. One interesting use of the bucket tool is to read black-and-white pictures
from the clipboard and colorize them. In order to prevent solid black lines from appearing in the
resulting picture, you may want to (carefully!) position the bucket within the lines themselves.

The  Rectangle(R) tool lets you quickly paint a rectangle, which you specify by dragging the
mouse from any corner of the rectangle to its opposite corner. Rectangles are always positioned
with their  sides parallel  to the sides of the display screen.  The current pattern,  and also the
foreground and background colors, are applied to the shape. If you've asked for hollow or hollow
bordered shapes via the Shapes window, you'll see the effect of this as you drag. Borders are
added  only  when  you  release  the  mouse.  If,  while  dragging,  you  want  to  discontinue  the
rectangle painting dragging the mouse into the menubar will cause the figure to go away  (unless
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and until you drag back). If you've already released the mouse,try clicking the Backup icon in the
Pure Colors window.



-7-
The Round Rectangle(D) tool works just like the previous Rectangle tool, except that the shapes
it produces have rounded (currently, circular) corners. Choose the degree of roundedness from
the Corners menu.

The Oval(C) tool is like the Rectangle tool, but it paints ovals. Note that the places where you
click the mouse and later release it denote the corners of the smallest rectangle that contains the
oval and therefore  will probably not themselves be points on the oval.

The  Triangle-Plus(T)  tool  is  a  new,  fledgling,  undocumented  feature  that  represents  one  of
several possible directions for future versions of ECP.It currently provides only two types of
triangles and one diamond. Enjoy it.

The Lines(L) tool lets you draw lines that reflect the current pattern and colors but which, unlike
with the Rectangle tool, may slope at any angle. As with the Rectangle tool and its cousins, you
may drag into the menubar to cancel a pending operation.

The Words(W) tool lets you put text on the screen. A variety of sizes and styles are availalble.
When you first click the mouse, you'll see a "blinker"; the cursor will be hidden until you move
it, and the blinker will move as you type to show the current insertion point. You may now type
characters from the keyboard, which will appear in the foreground color. If you make a mistake,
you may use either the left-arrow key or the <delete> key to back up. When you press the
<return> key, the insertion point moves to the following line, immediate below the point where
you first clicked. You may backup to previous lines, but not to previously typed segments of text.

The Mark(M) tool lets you sweep out a rectangular area for copying. The area being selected will
be indicated by an animated "markee". If you click inside this region while holding the mouse
down, you can drag it anywhere in the picture. By default, the region left behind will be set to the
current background color. If you hold down the Option key when you click, however, a copy will
be moved. In each case, when you release the mouse, the region will again be highlighted, but at
its new location. You may now drag it somewhere else, or sweep out another area for copying, or
change tools. If you have selected the Transparent item in the Cut and Paste window, portions of
whatever is being dragged that appear in the background color will not be moved To select a new
region that's contained inside the first one, first click the mouse somewhere outside the region.
You may also use the Cut, Copy, and Paste commands from the Edit window, or their keyboard
equivalents, to move a selected area to the clipboard. That is, Cut and Copy move it there, Paste
brings back a copy. This lets you make multiple copies in a picture, and it also lets you move
pieces from one picture to another. Finally, you may save a picture piece indefinately in the
Scrapbook desk accessory, using these same editing commands.

The Fatbits(F) tool lets you specify with a magnifying glass cursor a portion of the screen to be
blown up for closer inspection. The middle of the cursor corresponds to the middle of the region
to edit. If you specify a point too close to either or both edges, you'll be given a square to edit
that just touches the edge of the screen. To edit, click on the large dots in the large square on the
left.  This  will  cause  the  dot  to  be  replaced  by the  foreground color,  unless  it's  already  the
foreground color, in which case it will be converted into the background color. After clicking,
you may drag the mouse to edit more bits. The area you're editing is displayed in normal size in
the medium-size window to the right of the one with the fat bits. When you've completed your
editing, you may click either the "O.K." icon or the "NO" icon to return to the main screen, or
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you may click the cursor in the medium size square to the right of the editing square to specify
further editing.

The Keyboard
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You'll use the keyboard mainly for typing charcters in Words mode, and for giving the names of
files to be read or written to. The keyboard may also be used for command-key equivalents for
changing modes or defining line sizes.  If  you're  entering text  in  'Word'  mode,  however,  the
command-key is ignored.

Saving the Screen and Backing Up

It's easy to make a mistake. For this reason, ECP will automatically save the contents on the
drawing window when you change tools, when you click in the menubar, when you  press the
'Enter' key, and when you move a window. You may restore the screen to its appearance before it
was last saved by clicking the "Backup" square in the Pure colors window or by pressing the
'Enter' key while holding down the Option key.

Suggestions

1. The order in which you carry out operations can be significant. For instance, if you spill paint
outside a letter containing a closed path (such as "o"), you'll notice that the interior remains
unaffected. For this reason, you may want to wait until you've almost completed a picture before
adding  text.  Similarly,  paint  spilling  onto  a  dithered  pattern  (as  specified  by  the  Mixtures
window) will affect only a single pixel.

2.  Any suggestions or bug reports you can send me will be noted in future documentation or , in
the case of bugs, hopefully fixed before a future release.

[End of ECP 0.4 Documentation]


